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Your favourite image
printed on artist canvas
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330 £26

until end of May 2003
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CASDEC Photo Supplies & Imaging
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President’s Viewpoint.

This will be my last piece for the “Little Man’ as President of UPP and |
deem it an honour to have served this distinguished Society. | cannot express
my gratitude for being given this honour and my thanks go also to Len
Holman, our past President, and your hard working committee that have given

me their support throughout my term of office.

Now is the time to reflect over my term,
which | have greatly enjoyed and through
which | have come to know circles and
members more closely and have been made
aware of the camaraderie that exists within the
circles and UPP itself.

During this time | have seen modern
technology go forward in leaps and bounds
with digital cameras, software and printers
now performing to give high picture quality.
Gone are the days when it was said the
camera never lies. It also means that the
exhibitor can now produce an image to the same high standard without too
much difficulty.

| must say it was encouraging to hear rumour that there were some
members who would like to see a chemical only circle. Although | feel sure Liz
would be delighted fo see a circle of this nature, it would need a secretary to
run it.

When | look back over the AGM'’s, two events stand out. First we had
the one when our lecturer did not turn up and | was indebted to lan Platt for
standing in at the eleventh hour. My second was the Freeman Patterson
lectures, our first International lecturer who brought in the crowds. This meant
we had our largest membership attendance at an AGM.

As you will all be aware our AGM'’s have become more like a convention
taking in the Friday and Sunday. Friday lectures have been given by club
members, though last year Circle 11 gave their lecture as a group and | would
very much like to see it continue in this way. | feel it gives a greater insight into
the circles and the type of images they are producing, also those who
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witnessed the lecture, would have enjoyed the enthusiasm it generated,
both through the circle and in the images.

The Showcase CD, which was brought into being a few years ago, has
continued to be a winner and this has been due to the dedication of both Ken
(Payne) and Roy (Moore). They are improving the presentation of the disc each
year and making it very user friendly. They are hoping to present the slide
images this year through a digital projector, which one hopes will take much of
the stress away from the presentation and make it easier to manage.

At the start of my term | had said | would like to increase the
membership more and though in the early part the signs were encouraging,
this however has not been maintained. This is a great disappointment for all
the hard work both Liz (Boud) and Ann (Swearman) have put in. In the main
however our losses have been due to ill health and the march of time.

One has only to look around to realize, like so many clubs and societies,
we suffer from the fact that the younger element are not taking up these type
of hobbies the way they used to. As you will be aware most of our recruitment
is coming from our own clubs, whose members are also of our age group in
the main. We should not be discouraged as our format must be right as so
many of our members have been with UPP for a great many years.

Our new circle 44 has started to grow, which was set up for those
members who wished to retire from circle life yet still keep in touch with the
many friends they have made through UPP and like to enjoy the “Litlle Man”
throughout the year.

It is always a sad time when | have to inform you all of the death of one
of our members, and it was sad to hear in December of the death of Aubrey
Greenslade, who joined UPP in 1969 and who was at one time secretary of
circles 7 and 35.

Our sympathy and condolences are with Audrey’s wife Ruth and family
at this time. | would very much like to thank Ruth, on behalf of the club for
allowing some of his images to appear in this edition.

In October | was informed of a medical problem that lan Platt was
having and I'm pleased fo say that he is now well on the way to recovery and
is easing back into the mainstream of life; not to disappoint us lan has penned
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his normal article for this edition. It was nice to hear that during lan's
illness his humour was as sharp as ever and long may it continue.

Once again our AGM is almost upon us and a great deal of work is
being done to make the weekend as full as possible and I'm pleased to say
that circle 10 have taken up the mantle from Circle 11 and will provide the in
house entertainment for the Friday night lecture.

Barry is hard at work arranging the two Saturday lectures, which have
become another feature of our weekend, and | would also ask those members
who wish to book meals and accommodation at Hillscourt to make sure that
they help Barry by returning their booking form as quickly as possible.

Our Sunday visit has once again been left in the capable hands of Peter
(Young), who has arranged to take us to the ‘Avon Museum of Historic
Buildings’, which is a short trip from Hillscourt; and would you believe it on
that Sunday the 21¢, Rough Diamonds, a Victorian Living History group are re-
enacting Victorian life at the museum; | don’t know how you do it Peter.

As | said at the start of my address this is my last year in office and | will
be passing the Presidency over to the capable hands of Brian Davis, who |
know will, with an experienced members council behind him, take the society
forward; | wish him every success.

Finally | would like to thank those members who give so much help and
support to the club who are not council members or secretaries and yet are
always willing to assist in the presentation of the prints for the AGM. They
expect nothing in return for their time and | have seen many at the various
AGM'’s | have atftended.

So, once again a well-planned weekend is unfolding for those attending
the convention on the 19"-21%, September.

| very much look forward to seeing you there

John Bullen



FUJICHROME SENSIA 100

FUJICHROME SENSIA 200 -

FUJICHROME SENSIA 400 -

Peak

Performance

Who said you can’t improve on perfection!
Fujichrome Sensia has long been the benchmark for slide
film quality, with Sensia 100 setting the pace for all-round
excellence outdoors.

Now Fujifilm bring that leading-edge performance to
medium and high speed emulsions with the launch of the
all new Sensia 200 and 400.

Both feature Fujifiim’s revolutionary superfine Sigma Crystal
technology. Both deliver stunning results with lifelike colour,
ultra fine grain and incredible sharpness.
When quality is your main criteria for slides
or prints - make sure you're loaded with
Fujichrome Sensia.

You know it makes sense.

Available in 24 or 36
exposure rolls, both process -
and non-process paid.

) FUJIFILM

ALL ROUND OUTDOOR FILM FOR LANDSCAPES,

PORTRAITS & PEOPLE

VERSATILE, INDOORS & OUT, ISO 200 RATING OFFERS
ADDED DEPTH OF FIELD FOR SHOOTING AT HIGHER SPEEDS

STOP-ACTION SPORTS, LOW LIGHT & SHOOTING WITH
Z0OM LENSES

Editors View

On my last visit to my local photostore the manager suddenly said to
me’ No, | haven’t got one, | have sold it'. He was joking about the arrival, that
morning of an EOS 10D, Canon’s latest digital wonder. It had been snapped
by an eager customer who had continued to supply regular progress reports
over his mobile phone, such as ’ Has finished charging’ and ‘lts awesome’.
You have to be a bit envious in the face of such boyish enthusiasm and
happiness.

On the other hand | recently came across an excellent publication called
‘Grain’ produced by the Tonbridge Camera Club. In it was an exhaustive
article explaining why the author believed that the time had not yet come to
throw his 35 mm SLR away, in favour of a digital wonder. | confess that |
continue to share the writer’s views.

| have no doubt that using a scanned image, adjusting it and printing on
an inkjet printer produces better (on the whole) results than the traditional
methods, if only because you can correct errors more easily. However, going
all the way and using a digital camera to take the original picture is one bridge
too far for me at the momemt. No doubt the time will come, but not yet.

| do have a small ‘compact’ digital camera, ideal for parties and group
pictures and even close ups. Of course, since | have had it for about 3 years it
is completely outdated and a new one would perform much better. Even so |
notice that serious reviews still frequently mention important lens faults.
However, were | to buy a replacement | could at least hope that the basic
configuration of this class of camera would remain the same.

In the serious amateur/ professional field that is by no means the case.
Not even the type of chip is decided, let alone the size. | conceive it entirely
possible that the future format will more closely approach the APS format than
the 35 mm. Assuming that next year’s chips will have resolution several times
higher than those available today, why carry a 400mm lens around when you
can achieve the same result with (say) a 100 mm lens and a 2x digital zoom.

The future does look wonderful, provided our newsagent and friends

continue to buy today’s marvels with continuing enthusiasm. Only thus can
development be financed. For my part, I'm off on holiday with loads of film.
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As you will have read, this is John Bullen’s swan song as President. In his term
of office he has had to put up with a number of problems caused by this
editor’s errors and omissions. | wish to put on record his amazing kindness
and tolerance in this and other transgressions. Under his leadership the bunch
of individualists known as the Council has functioned smoothly.

Walter Steiner

Umpteen P hotographic Places (Otherwise known as a Membership drive)

This last 6 months we have been struggling to find black and white print
and slide workers. We have blended two small print circles into one and we
may have to do the same with two slide circles. “Why2” you ask, Well my
thoughts are that DI has made it easier to produce prints at home, instant and
with no mess. Members who could only show slides after setting up their
lounge with projector and screen, can now have their prints framed on their
walls for all to see. Darkrooms made from bathrooms or spare bedrooms are
now a thing of the past, so partners are happier. Most of our print circles now
except DI as well as darkroom and trade. So should we not realise that this is
the path of change and be proud that UPP has embraced this 20th century
technology, | think so, but not at the price of the traditional methods of
photography which is such a demanding art form. | feel UPP has the ability to
provide circles for everyone. To do this we must try and keep some circles
dedicated to traditional styles even if the numbers are small. UPP cannot say
we are a photographic society and only provide for the majority. Like fashion,
back in the 70’s | was sure | would wear my flares again, had it not been that
they are 4 sizes too small, | would be wearing them now. So if you have space
in the attic and you did love developing your own prints or slides don’t throw
your darkroom equipment away, you never know 2010 may see a revival of
the fascinating art of the darkroom.

Please ask your friends around to see your circles folio and help us find
new members. See the membership application form on page .40

Liz Boud Membership Secretary
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UPP 2003 CD

The UPP CD of all the gold label slides and prints has been a huge success
since it was introduced in 2000. This year’s CD will be even better with less
work to do for navigation if you so wish. The program has been written in
software called Flash and is completely self-contained and does not require
your Internet Browser or any other program to play it. Just put it in your CD
Rom Drive, wait for it to load up, click a couple of buttons and sit back and
watch the show, a baby could do it. If you wish to set other options such as
fading pictures in and out, listen to voice over, music on or off etc., all these
will be available to set with just one click of the mouse on the relevant button.
The quality of the pictures will be up to the usual high standard and | can
assure you that you will not be disappointed. The cost for this year’s CD will be
£10 (no increase for three years) if ordered before or at the AGM. After this
there will be £1 extra for post and packing. Orders placed before the AGM
will be sent out a day before the AGM. The CD is the copyright of UPP and |
would ask you please not to copy it for friends as what profit is made helps to
improve the quality of our society to your benefit.

KEN PAYNE Print Competition Secretary
and CD coordinator.

Choosing the Pictures in the magazine.

The pictures fall into several categories. Some are there as essentials.
Winners of Trophies, Winners receiving their prizes, portraits of officials
and those attached to arficles.

Others, such as the colour pictures in this issue, are chosen arbitrarily
by the editor.

In order to make the choice more broadly based, Circle Secretaries are
invited to send in their suggestions for pictures. The maximum number
of colour pictures is, at present, limited to 8, because of the cost of
printing colour, but in greyscale the number is limited only by increases
in postage. In some cases it may be worth printing a colour picture as
monochrome
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City of Swansea Exhibition of International
Photography2003

This is possibly one of the largest undertakings Swansea Camera Club
has proceeded with since its birth way back in the 1840s.

However, it is fitting for the exhibition that Swansea Camera Club is in
association with The City and County of Swansea, Swansea Institute of Higher
Education and The Welsh Photographic Federation. It is hoped that this
exhibition will become an annual event, for that we need the support of you,
our entrants.

Swansea, the birthplace of Photography, will once again be a focal
point for photographers from around the world. Entries, of slides and prints,
are expected from around 50 countries with several hundred photographers
providing over 2000 slides and 2500 prints.

Judging will take place on October 4™ and 5™ by a panel of six eminent
judges with Patronage from the Photographic Society of America (PSA) and
from International Federation of Photographic Art (FIAP).

Medals of gold, silver, bronze, together with ribbons, certificates and
highly commended will be awarded to those achieving the highest standards.
Entries may be made to any or all of the six sections. Entry forms can be
printed from our website www.swanseaphotoexhib.info or E-mail your address
to philip.davies@tesco.net.

However all UPP members will receive entry forms around the end of
June and will be able to hand in their entries, and any others they can bring
along, at our AGM in September thus saving postage cost. You can also enter
Smethwick direct from Swansea and get your prints/slides back from them.

There will also be a medal and CD presented by our President to the best
print entry within prints on the theme of Dylan Thomas, his life and his works.
An exhibition of prints is to be held at the Grand Theatre Swansea and at the
Dylan Thomas Centre where we will hang around 40 of the Dylan Thomas
prints. The exhibition will also go to other venues.

At least six other venues throughout Wales will see the presentation of
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the accepted slides and a further range of accepted prints.

In getting our International known we are indebted to Smethwick
Photographic Society for allowing two of our members to attend their
International judging in 2002, to learn how they organize their Internationals
and by giving ours a big boost by sending out our entry forms to the 1000
plus entrants they had that year. Our sincere thanks go to them for their
cooperation and to Southampton; Scottish; Welsh; and South Shields who like
UPP are assisting us.

Philip Davies Chairperson Swansea Camera Club.

£85 Club  Portfolio
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Profile

| suppose it would be fair to say that just became ‘involved’ in
photography rather than having chosen it as a recreational hobby.

It all started when as a very junior officer on a course at R.A.F. Henlow,
that an NCO asked me to take some photos of him and a few others, who
were to be drafted abroad. Having done so and returning the camera, | was

" |

surprised fo be told “ you can keep it, sir, | won't have any use for it now
was also subsequently given a box containing
412" wide film ( RAF for the use of) and a
long metal template. This was for use in
cutting the film in half width ways and in
lenghts equivalent to a 120 rolll Mastering
the technique whilst kneeling at the side of the
bed with all the gubbins tucked well into the
middle under the blanket, and a razor blade, -
resulted in a scarred left forefinger and bloody -
sheets |

In 1944 with my wife pregnant with our
first child, | decided to acquire a less
antiquated camera and it was whilst
searching the for sale columns of a copy of
the AP that | saw an item about UPP

e e

Ultimately | was directed to Wilf The Author
Lawrence who was secretary of C12 (later to
became C20). What a great fellow he was, headmaster of Irthlingborough
School in Bedfordshire and a great organist. Over the next few years, my wife
and | visited him several times and he us, and | owe much to his gentle advice
and guidance. As a complete novice | joined UPP for the benefit of the
opinions of more experienced workers and | still, to a certain degree, have the
same principle. My circle entries are always "virgin’ prints, that is fo say are
‘first off” pictures never previously produced. It is on the opinion expressed on
the crit sheet that | decide to discard or work on, the neg for club or exhibition
use.

My lengthy association with UPP has brought me great pleasure as well
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as increasing my human understanding.. In 1957 | became Hon
General Secretary, which | held for 3 years and during which time |
reorganised the Council format. At that time my dear wife assisted me in twice
yearly addressing over 600 envelopes . From 1961 to 1982 | served as Vice
President and then until 1990 as president. | then handed the job over to our
dear departed friend, Ralph Couchman. Now | am a Honorary Life member of
Council, an honour | greatly appreciate and for which | am greatly indebted to
John Bullen and my fellow members of Council.

| have seen many changes during these years, both subtle, gentle
developments, as well as major ones,
such as the acceptance, ultimately, of
commercially produced colour prints,
the change in venue for the A.G.M. out
of London,thanks to the initial
endevours of Ralph, but ultimately
secured by Alan Homes. The biggest
change was to digital imaging
undertaken and controlled by Len
Holman, for whom | have the highest
regard. Well done, all three Presidents.

Photography means different
things to different people. To some it
almost becomes a way of life, to
others a hobby intended to bring
relaxation from every day stresses, into 5.
which category | place myself. RO.

Stanley (on the right)
with his wife to be

In the early 50’s we started to go to Europe for our holidays in the car,
package holidays not yet having become fashionable. A cine camera was
added to my equipment , which | found an excellent way of recording life like
images of my youngsters’ activities. My still" photography proved a great help
in choosing viewpoints and suitable lighting to enhance the scene, as well as
the technique of using a ‘movie’ camera with zoom lens. When viewing some
of today’s videos it becomes obvious who has had previous photographic
experience.

In 1960 a lecture | attended drew my attention to ‘Stereo’ and | decided
to give it a try. | enjoyed the added realism of 3D effects over my normal
transparencies but affer a couple of years | tired of the added burden of yet
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another camera and the difficulty of viewing, so stereo was forsaken for the
cine.

In 1973 Photography magazine ran a portrait competition for
individuals and clubs. UPP invited submissions for selection for our club entry
which had to consist of a child, indoor and outdoor partrait.

- | was fortunate in having two
| of my pictures accepted. The entry is
* reproduced here. Later the ‘Priest’
became my first R.PS. acceptance.
‘Ted Arkell’, a fellow member of my
tennis club was spotted by an
advertising agency and resulted in
my being commissioned to

- photograph him for DuMaurier

: cigarettes, smoking, of course! This
: =4 also led to other lucrative

5 e = e commissions.

Deckchairs

Another piece of good fortune about this time was the winning of the
major prize in a competition organised by a national newspaper, the Standard
| think, and sponsored by Kodak and Alitalia Airlines. It was for both colour
and B & W with similar prizes for each but a major prize for the best, which
consisted of a (then just introduced) Instamatic camera and a 2 weeks holiday
in Italy for my wife and me. The irony of it all was that the picture, 2 deck
chairs, had been shot in Spain and the film was llford FP4. However, the 20 x
16 print | was asked to produce for the presentation was made on Kodak
paper !

In 1957 | gained my Associateship of the R.PS. in ‘pictorial’ and my
judging activities commenced. which | still pursue and greatly enjoy.

| had a shot at my ‘F’ but it was made clear to me that it was necessary
to specialise to be successful, which is not for me. I'm just a spontaneous
photographer, except perhaps for club set- subject competitions. | never go out
with a preconceived obijective. | have no illusions of being ‘creative’ and rely on
being attracted to something by virtue of the subject matter or lighting effect
or preferably both. Composition is an important aspect of any picture and
whilst the rules of composition are very helpful, | personally consider it
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Dartmoor Ponies L.R.

Generation Gap

instructive rather than sacrosant. For me subject interest is the prime factor.

You will find people figure frequently in my work, which | feel is
influenced by my background of strong family ties, wartime camaraderie and
friendly disposition. Also it was my good fortune to be introduced to Margaret
Harker, then principal of the Regent Street Polytechnic in London, later the first
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Professor of Photography, who encouraged me to take the professional course
of portraiture run by the Polytechnic. It was flattering to know that my 21/4
square camera could compete with the school’s plate cameras.

In my opinion using a
figure in a landscape
or general scene not
only generates a centre
of interest, but also a
sense of animation in
what otherwise could
be a lovely scene but
devoid of life. As for
equipment, | use both
35 mm and 645 with
the larger format e
preferred for my B & W Canal Walkers L.R.
work The 35 mm is used for both transparencies and B & W, especially my
mono |.R.

My other hobby is golf Both these
hobbies are strictly recreational and both
need concentration and practice. They
differ in that when one gets home from a
spell with the camera the work is just
starting.

In closing let me say that whilst |
greatly appreciate the skill and technology
involved in digital/computer photography,
| am happy to pursue my hobby in the
more traditional way, any way | LOVE the
smell of chemicals !

Miss Cynthia

Stanley Berg ARPS APAGB
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The twenty-first century at last

In most stable societies changes occur gradually over a period of years
and in an evolutionary manner. Great Britain resisted the eighteenth century
wave of revolution which swept through Europe and perhaps was the better
for adopting a more calmer attitude to change. However, in present
photographic circles no such softly softly approach has taken place with the
digital revolution which has swept through amateur photographic circles like
an Australian bush fire. Nothing evolutionary about this, it has been an
astonishing revolution without parallel in amateur photography. People have
been falling over themselves to cast off their darkroom appendages in their
endeavours to adopt the more comfortable stance of sitting in front of a
screen to create the masterful images which they believe escaped them when
adopting the more “conventional” tools of the trade. | often wonder whether
the current worship of The Box has encouraged them along this line of activity.
Comfort also perhaps has had a hand in the change as | overheard recently a
well known worthy commenting that when he got too decrepit to stand in front
of an enlarger then, and only then, would he take to the digital mode !

Listen in to any conversation between two or more photographers
nowadays and without doubt the subject will be of a digital nature with total
emphasis on technique. Talk will be about the latest gizmo; what magnificent
sharpness can be obtained by using such and such an approach; the speed of
production; the wizardry of Photoshop 6 or 7 or whatever; what wonderful
“quality” (whatever that is 2) can now be gained at the flick of a key. Very rarely
indeed does a mention of subject matter and “pictorial” (again whatever that is
2) content ever occur. It is as if the God Technique has taken hold of us all to
the detriment of all other qualities which once upon a time held sway.. Do you
remember Riccado of The Amateur Photographer and the “Old Codger” who
between them sorted out such things as the “rules” of composition and
aesthetics ¢

| must make it clear that | have absolutely nothing against Digital
photography. In some ways it has been a godsend for many camera clubs and
perhaps UPP in particular with its many Digital Circles now so well established
and producing some excellent work. Perhaps again it has rallied the
enthusiasm of many who were beginning to lose interest in this grand hobby of
ours. All this is to the good but the oft quoted hope that the Digital revolution
would bring in the youngsters has not unfortunately materialised but | suppose
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there is time yet for this o take place. Let’s hope it does because there are
many photographic societies on the brink of collapse through lack of
members.

Like all new phases, particularly those that come in with a rush, we have
seen changes occurring rapidly in Digital work. At first every opportunity was
utilised to incorporate all the gimmicks which Photoshop had to offer with
many pictures consisting of images taken from every quarter of the world only
to finish up as an incomprehensible jumble. Clearly very clever but
meaningless? Gradually we have seen a seftling down of this all-embracing
urge and pictures of some pictorial merit are now emerging. As the process
develops (I) even further worthwhile styles will no doubt be seen with ultimately
a settling down to a common acceptable standard. We shall then be ready for
the next great leap forward, whatever that might be. As | wrote once before we
may then be into images being conveyed from the viewer’s eye direct to the
computer and beyond. Possibilities are endless and we should take every
opportunity to exploit them to the full.

One thing is certain, we have at last, after too many years in the
wilderness, escaped the clutches of our founding photographic fathers who
were always attempting to emulate the Old Masters with their soft focus and
strict adherence to the rules of composition. If the Digital process has done
nothing more we can be thankful to it for bringing photography at last well
and truly into the twenty-first century. More power to its elbow. Here’s looking
at you Sam - through a screen brightly, of course |

Onlooker

The UPP website
is at
www.uppofbg.org
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Salon Selection - Some Anomalies

Although only a small percentage of the readership of Little Man may
actually enter Salons/ Open Exhibitions, many more are interested, or at the
very least curious about, the methods of selection used in these events.

A single selector, such as employed at certain low-key Open events such
as Winchester or Havant, has the luxury of choosing what method he/she
wishes to pick from the total entry the number of prints and/or slides the
organisers want.  But as soon as you utilise the customary three selectors,
complications can arise, particularly where consensus is concerned.

To the uninitiated it might seem perfectly reasonable that in choosing
photographs deemed worthy of acceptance into a given exhibition, a measure
of consensus among the selectors should be the norm. Some events do run
this way, but thankfully they are in the minority.  To elaborate, you may feel it
completely reasonable that an IN, IN, OUT vote from three selectors would
result in an entry being accepted whereas an OUT, OUT, IN vote would not.

It goes without saying that complete unanimity either way will result in an
acceptance or rejection as the case may be, but as will be revealed shortly,
even this is not guaranteed in certain circumstances!

Exhibition organisers usually choose their selectors with some care,
trying where possible for a good cross-section of experience and interests.
This should result in an exhibition that covers all aspects of good photography.
Many events also utilise some sort of non-consensus selection that permits the
occasional very strong opinion concerning a given entry, fo guarantee its
acceptance and not risk being overruled by the other two selectors.  This is an
ideal situation, because it allows individual choice to result in a more varied
exhibition than might have been the case otherwise.

To simplify as well as speed up the task of selection, the most common
method used today is by an electronic voting machine. Selectors are invited to
utilise just 4 choices and these are usually identified as: OUT, 2, IN, and
DEFINITELY IN. The ‘2’ vote is sometimes identified as a ‘maybe’ or a ‘near
miss’. Because it is impossible to add up three different votes as described,
the voting machine handset used by each selector is usually inscribed with
scores, and these are invariably 2,3, 4 & 5 (although there is no reason at all
why they shouldn’t be 1,2,3 & 4). However it is wise NOT to think of these
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scores as marks per se, because they are really very broad bands. For
example, a picture not considered good enough for acceptance will be given a
2 whether it is just below standard or a long way short. Also the 5 score is
usually given to pictures of outstanding quality - such as potential award
winners, as well as work the selector would like to see accepted for reasons of
variety.

So far so good. We now have a hypothetical situation with three good
and trusted selectors, a sizeable entry of prints/slides, and off we go. It is a
fact of life that in almost every case | have observed, either as a judge/selector
myself or as an organiser (Smethwick, Midland Salon, Surrey Creative Salon &
Southampton), the number of photographs that the selectors ‘choose’ to
include in the exhibition far exceeds the number the organisers feel able to
accept.  The reasons for this apparent anomaly is that the organisers have a
finite number of prints they are able to hang in their chosen venue and also a
similar situation exists with the number of slides they feel able to show. The
international body FIAP (International Federation of Photographic Ar)
recognises that this may often be the case and they do not require that every
accepted picture must be shown. Indeed, FIAP actually stipulates that
“organisers must exhibit all the prints and show all the slides accepted by the
jury. In the case of lack of space or an excessive duration of the slide show,
the jury chooses amongst the accepted works the prints to be exhibited or the
slides to be projected.” This is seldom if ever donel

What organisers tend to do is to invite the jury to downsize the number
of works they have accepted. A clear case, in my opinion, of the tail wagging
the dog!

Organisers can become totally involved in the ‘numbers game’ that
results from the plethora of total scores being recorded. These vary from as
low as 6 up to @ maximum of 15, and it is, to some small extent,
understandable that in drawing the line beneath the lowest score they deem to
be the accept mark on the day, they can lose sight of the fact that the jury
clearly wanted to include work that is now being excluded!  Frequently one
sees a Report Card from an event with an acceptance score of 12.  This
means all those pictures scoring 11 - almost invariably made up of a 4,4,3
vote (the majority voting in favour of acceptance), are doomed to be recorded
as rejects.
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The selector who recorded the 3 vote in effect decides whether the
photograph is accepted or not. In a majority of cases all three selectors will
be more or less equally involved in the use of the 3 vote in a score of 11
resulting in a reject. But occasionally (thankfully rarely) it appears that one
selector is out of step with the other two for much of the judging and a
situation arises whereby one individual de-selects pictures, overruling the
other two. Sounds crazy | know, but it can and occasionally does happen.
On such occasions it usually only becomes obvious when the out-of-step
selector is using the 2 against the 4’s from the other two selectors.  When a
series of 10 scores are revealed after two of the selectors sitting adjacent to
each other have voted IN (4) it usually becomes self-evident and can then
sometimes lead to one or both of them overcompensating later on.

The last time this situation arose when | was among the jury, | politely
enquired of the organisers what they would do if | chose to award my personal
medal to a picture that was going to be rejected!!l  They laughed the idea off,
of course, knowing that | would do no such thing because | had clearly used
the 5 score many times and would (almost certainly) choose to give my
personal medal to one such picture, which was accepted regardless of its total
score. However, this was not an entirely hypothetical question because when |
judged in Linz a few years ago, | awarded my medal to a slide that had scored
below their usual acceptance score (the situation was even more complicated
by having 5 selectors instead of the usual 3) and they were not using a non-
consensus selection system. They graciously allowed me my choice; the
picture was also illustrated in the catalogue and evoked quite a lot of interest
and favourable comment | later learned.

For the last two years my wife Patricia and | have organised the selection
of the prints for the Southampton International exhibition. We have accepted
every print the jury wanted to accept.  There were no 9 scores made up of
5,2,2 but there were several 10 scores either made up of 5,3,2 or 4,4,2 and
in both cases they were accepted, as too were all the 11’s and above. To
further widen the non-consensus selection, the jury only had fo agree on the
five major FIAP medal award-winning pictures from among the 1400 or so
prints received. Then each selector was given complete freedom to choose
their own favourites that were to be awarded a Medal, FIAP Ribbons or
Certificates of Merit.  The resulting high number of acceptances does mean
that we are unable to show them all, but will however display a good cross-
section of work from all the entering countries. However, if you were
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unfortunate enough to enter the Nature slide section of the same exhibition,
where a different team used different criteria, you would need a score of 13 to
guarantee acceptancel!!

lan Platt, MFIAPFRPS,HonEFIAPAPAGB

Three in a Crowd

Pictures by
Audrey Greenslade
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11Fairwayll,
6, Lullington Close,
Seaford, EN25 4JH

30.12.02.
Dear Members of U.PP

As many of you are already aware, Aubrey died from cancer on 10th
December.

| would like to thank all those
members of U.PP. (especially those
members of Circle 7 and 35), who
sent me so many lovely cards and
letters. Aubrey thoroughly enjoyed
acting as Secretary of both Circle 7
and 35 for many, many years until
quite recently when Dave Bennett
kindly took them over. He really looked
forward to the yearly A.G M. which he
always tried to attend.

The other day | came across this
quote which Aubrey had written and |
think it really sums up his approach to
photography

“Photography, for me, is
primarily an incentive; an incentive to
look carefully at ordinary things. ‘To
search for pattern and mood,
nostalgia, perhaps, at times. The biggest thrill is in discovering a picture in an
unpromising subject; another in successfully translating it into the final print.
But full satisfaction requires that the results should be shown to others, for art
does not exist until it is appreciated.”

B R e

Thank you all again,

Ruth Greenslade.
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Pyramidal Orchid
and Snail
by Adrian Langdon ARPS

Derwentwater

The Croft by Tony Poole
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by Derek Larkin )
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Looking Ahead
by
Anne Swearman
ARPS DPAGB
APAGB

Twin Towers by
Dave Bennett

Twin Towers (opposite page)

Twin Towers is of course, the Humber Bridge. It was taken from the
south side of the River Humber during July 2000 and was the final picture of a
series taken as the sun was setting.

It had been a very hot day but towards early evening the air became
cool and damp so | knew we could expect a good sunset. Unfortunately, from
a photographer’s point of view, there wasn’t a cloud in the sky. Quite a few
onlookers had gathered at the viewing area to watch the sun go down and |
followed its progress, taking pictures from various vantage points. It is
surprising how quickly the sun sets and it soon slipped out of sight below the
horizon, at which point all the onlookers retreated to their cars, on mass and
left. Within minutes the area was deserted, what a treat they missed, for the
best was yet to come!

The afterglow lit up the sky and, as the light dropped, the sky took on a
whole range of colours from pink at the horizon changing through to deep
blue. | took my “Twin Towers” and within a few more minutes it was pitch

dark.
Dave Bennett

Looking Ahead (opposite page)

‘Looking Ahead’, is one of the most difficult pictures | have ever
produced, although it appears very simple. The idea came when | was helping
my four year old grand daughter to get ready for her dancing class. | thought
it would be a good idea to have her in the background, with an older dancer
in the foreground. Plan ‘A" was to take a picture of Eleanor with a bland
background, and insert the older dancer from some other venue. Plans ‘B,
'‘C" and ‘D’ petered out. | must have been up to about plan ‘G’ when our
Federation had a ‘Day of Photography” which involved me inviting some
models from a dancing school to pose for photographers in a studio set up. |
had about 5 minutes with my model. ‘Sit here and pretend to be putting your
shoe on” was all | had time to say, although | had had the foresight to ask if
she could bring the dress and shoes. Three grab shots by a window, and | was
off like a rocket to attend to my D.I demonstration. The next piece in this jig
saw was to take granddaughter and daughter to the local dancing school.
‘Hold your skirt out Eleanor” my daughter said from behind me. | grabbed the
shot, and now all | had to do was merge the two shots. It sounds easy but it
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wasn't. | must admit that it is the expression on Eleanor’s face that really
makes the picture work so well, and like all pictures it has that elusive element
of luck as well as planning.

Anne Swearman ARPS DPAGB APAGB
The Croft (page 29)

The picture was taken on a Colin Westgate photographic trip to Skye in
October 2000. The weather was extiremely windy but bright. The camera was
a Nikon 990 digital stopped down to 9.3 and shutter was set to auto. Apart
from removing some electric cables and a pole, | also took a bucket from @
chimney pot, | can’t remember which one. Apart from that the print is straight,
for me 2000 was early days for my journey into Photoshop.

Tony Poole

Desert Landscape (page 27)

For the landscape photographer sand dunes have always been a great
attraction whether they are the great sweeps of the Sahara or a few ridges by
the sea in Cornwall.

Death Valley in California where this photograph was taken, comes
somewhere in the middle - relatively small but beautifully formed! The area of
sand dunes covers a few square miles near to Stove Pipe Wells which
fortunately sported the necessary accommodation for us fo survive
comfortably in an otherwise hostile environment. Our first trip was one
September when the femperature rose to 112F in the shade and all my
photographs were slightly underexposed because | had trusted the exposure
meter on my Olympus OM4ti.

Even worse, many shots had been spoilt by footprints no doubt created
by fellow photographers earlier in the day.

| resolved to do better and returned the following year in October. This
time there was a slight wind which kept the dunes free of footprints - those
shown in my photograph were deliberately created by me to link the
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foreground with the background.

| used the camera exposure meter but bracketed my shots and most of
the best tones were overexposed by half a stop.

Having had a year between trips to think about the possssibilities, | was
able fo return home with a variety of pictures: some texture, some shadow
outline and some middle distance landscape. The result was a panel of fiffeen
prints successfully submitted to the Royal for an ARPS distinction. The prints
were scanned with a Nikon Coolscan 2 from Agfachrome slides and then
printed on an Epson PhotoEX printer. The help and advice | received on the
technical side from some DI 3 circle members was invaluable in producing
good quality digital prints.

Graham Coldrick ARPS

Pyramidal Orchid (page 29)

| took the picture in the sand dunes at Daymer Bay in North Cornwall
which is about 5 miles from my home.This is also part of the St.Enodoc golf
course but luckily there is the famous St.Enodoc church which was reclaimed
from the sand some years ago and it has numerous public footpaths across
the golf links to it. This is also the churchyard where the Poet Laureate Sir John
Betieman is buried.

It was taken with a Nikon FP0X and Tamron 90mm macro lens. F22 at
whatever speed with fill-in flash and a reflector. Also on a Benbo tripod.

These orchids are very common in Cornwall in the summer and on the
dunes they collect large numbers of snails on them, sometimes so many that
they obliterate the flower spikel!

Adrian Langdon ARPS

Closing date for articles for the Autumn edition is
15th September 2003
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Avutumn Light (page 27)

Was taken several years ago on a N.C.PF. Autumn weekend based in the
lakes. We had for most of the week end the usual damp drizzly weather often
associated with this area. We were driving in the Tarn Howes area when
suddenly out of the blue the burst of sunshine appeared. It was fortunate that
we were near a lay by which afforded me the view in the photograph. The
sunshine only lasted for about 5 mins. It was taken on my Pentax Z20 with a
28-80 zoom, probably at the 80 end. | used a tripod so would have an F stop
of 16 and let the camera work out the exposure. | bracketed to make the most
of the opportunity but the camera was about right.

Val Burdis DPAGB
Derwent Water (page 28)

The Lake District is one of my favourite places. | try to get there at least
twice a year. The best times are early June and the second week in September.
| always stay in Keswick, the north end of Derwentwater is only about ten
minutes from town, The evening light is the best time on this part of the
lake.Early mornings are spent at other locations. Where and when the light is
right, that's the place to be.

May the light be with youl!

Brian Elms

Archivist

Howard Fisher LRPS CPAGB, Secretary of Circle 21 has agreed to
act as UPP Archivist. If you have any material likely to be of interest to
him, please contact him, especially if you are about to throw it away. For
contact details, see page 52.

A detailed explanation of his duties will appear in a future edition.
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Roland Jonas Trophy and Plaque
The Cheviots
by Colin Westgate FRPS MFIAP APAGB

‘The Cheviots” was taken during a March walk at the end of Harthope
Valley in Northumberland. | do not use wide angle lenses very much, but the
clumps of tussock grass caught my eye, and | wanted to emphasise the sweep
of the grasses towards the distant Cheviots. Fortunately, there was still some
snow on the summit, which enabled the hill to stand out from the dark sky
background. The print was made on llford Multigrade, using the split grade
method of enlarging by exposure through soft and hard filters, the ratio of
each being ascertained by two test strips, the first through the soft filter to
provide the highlight detail, and the second through the hard filter, overlaid on
the soft, to put in the shadow and mid tone density. The sky had some extra
burning in through the hard filter to add a little drama. The camera was @
Minolta Dynax, with a Sigma 17/35mm zoom lens.

This Picture was published in the Autumn edition, but the article was
omitted
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Focus 2003

On the 24" February, |, and hundreds of others, attended the Focus
photographic exhibition at the National Exhibition Centre, Birmingham, the
Mecca of photography, where all manufacturers, and producers were
represented, hoping to impress us with their latest offerings.

Among the crowds entering the exhibition on a cold February morning
was a young lady who appeared not to be wearing a skirt. Some time later
some one noticed she was wearing a horned helmet and carrying a spear.
“Probably a photographer’s model”, we thought.

The exhibition hall itself was jam-packed with stands. We arrived around
10 am and were due to be picked up again at 4 pm. Although we thought
that six hours would be far too long, in fact we didn’t quite manage to get
round all the stands in the time available.

All the great and good in photography were represented there, together
with some up and coming minnows. Basically we were looking at the future of
imaging and the latest techniques used in picture creation. Such as digital
imaging, this being the really big feature of almost all exhibitors, yet with
traditional cameras still well represented. It seemed to me that the enlarger
stand was not very busy, except for some interest in a couple of enormous De
Vere models.

| overheard a lady complaining to the Kodak representative that her
Epsom printer was producing poor results with Kodak paper. He said she
should see the printer technician around the other side of the stand and ask
for his advice. “| have already,” she said, “and he told me to see you!”

Surprisingly there was not the complete wipe-out of film cameras by
digital ones that | had expected. In fact about only half of the new cameras
seemed to be the digital variety It must be something to do with cost, as four-
figure sums were quoted for digital cameras, as opposed to three figures for
the equivalent film varieties. Folks could try out the latest cameras from all the
big manufacturers, but heavy chains supplied firm anchors to ensure that the
equipment remained in their intended places throughout the whole day.

The Adobe Photoshop stand was extremely well attended, being laid out
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like a small lecture theatre. The demonstrator knew his stuff but was not
easy to follow as he pulled out the esoteric functions of Photoshop 7, and its
more affordable version Elements, all with dextrous use of the Wacom tablet.
There was not a mouse in sight next o any computer at the exhibition. Instead
Wacom tablets were widely used, as they gave give far more precise imaging
control than any mouse.

Strangely the demonstrators seemed to speak with either German or
American accents. The only guy speaking perfect English was a Japanese
Epson rep as he extolled the virtues of their latest printers to a crowd of eager
punters. The results produced by these machines were really superb. | could
not tell the difference between the inkjet prints and those produced by
conventional wet processes, except, perhaps that the inkjet versions were more
vibrant.

The black inkjet company Lyson were there with some outstanding prints
as examples of their products. | thought the representative was rather harsh
on his own products when he mentioned residual metamerism as a problem,
this being the slight false colouring only apparent when you view the prints at a
very acute angle under special lighting.

| was impressed generally by performance of larger inkjet printers as
produced by Epson and others. When | say larger inkjet, I'm not talking about
5 x 7 inches samples, but 5 x 7 feet posters. (OK, let's be up-to-date, 1.5 by 2
metres).

Fuji were displaying a digital trade film processor, “only £95,000 to you
guv. Terms available, with 5 years guarantee.” But when | looked closely at the
machine | saw that although the scanning and exposure of the films were
digitally controlled, the actual processing was still carried out using
photographic paper. No doubt in darkest Japan, even as | type, some cunning
plan is evolving whereby future processing will done by an entirely digital
method.

At the Paragon studio crowds of blokes were surrounding models
dressed up as uniformed schoolgirls complete with pigtails and gymslips. The

results were actually better than the girls looked in real life.

Other girls mingled with the crowd dressed in Agfa film outfits.
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The Paterson’s stand had the traditional photographic darkroom
offerings we have all used over the ages, such as focus finders, dish warmers,
safelights, efc. while next door at the Permaijet stand the latest gadget for
avoiding the need to buy expensive Epson inks was being demonstrated.
Permaiet offer an adapter kit for feeding Epson cartridges from separate
reservoirs via tubes and large bottles of ink. “What an excellent idea - never
run out of ink again ”, | thought to myself, until the snags were revealed. At
about £300 you would need to get through about 15 Epson carfridges before
you break even. Also you need to flush the system about every 6 months to
avoid clogging the nozzles. Even so, the idea of separate refillable ink tanks
seems an excellent idea, even though I'm sure Epson would disagree.

The Nikon stand was a very impressive structure, resembling a tower
overlooking the exhibition hall. At its base were Nikon-clad nubile ladies
aftempting fo sell advertising products. “Buy your Nikon bum bags here, only
£5 to clear,” they were calling out to the punters going by. After | had climbed
the tower, expecting to be rewarded with a cornucopia of photographic
delights, all | could see were three cameras fitted with the latest telephoto
lenses securely chained down to the surroundings. Presumably, Nikon had
decided that you need height to appreciate the distant pulling power and
performance of their lenses.

What surprised me was the presence of a Salvation Army stand, and
how well attended it was, with rows of occupied seats. | couldn’t quite see the
connection with photography but there were lots of blokes drinking steaming
mugs of tea while being told by a presenter that Barry Thomas, the Photoshop
guru, is at present in Australia.

| could have carried on further around the exhibition, but by then time
had run out and | had to return to our coach. On arrival we all agreed that
the exhibition had been very well organised, certainly worth attending and that
it had been an excellent day out to see the future of photography. Hopefully
some of the excellent offerings on display will make their way to us all in the
not too distant future.

Dennis Apple Circle 9
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Hillscourt Conference Centre is situated in the
beautiful wooded Lickey Hills and is within
2 miles of the M42 and M5 motorways.

Open all year.

« Day conferences up to 200.

+ Extensive gardens and grounds.

* Photocopying, telephone and
fax available.

s Rirst-class food.

23345

r Hillscourt provides excelletit vaby
~ has its own licensed bar and;

Rose Hill. Rednal, Birmingham, B45 8RS.
Telephone: (0121)-457 8370 Fax: (0121)-457 8521
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United Photographic Postfolios of Great
Britain
Membership Application Form

Full Name\Distinctions

Address
Town County
Postcode
Telephone

Email Address

To ensure that you join a circle that will correctly cater for your per-
sonal interests, please tick the appropriate box.

A3 A4 A5
Monochrome

Colour only

Mixed

Digital

Slides 2°X2" D General Natural
History

Non Voting

Please enclose a cheque made payable to U.PP

Joining fee £ 2.60

Between 1st September-30th April £13.00

Between 1st March and 31st August £ 6.50

Additional Circle £ 2.50

Post this form or a copy of it with cheque to membership secretary Mrs Liz
Boud, ‘Barnjet’, Cuttingley Road, Crawley Down, West Sussex, RH10 4LR.
Telephone number 01342 71 73 18, email liz@bouddi.freeserve.co.uk

40

Making 3D Pictures by the Red/Green Method
(Anaglyph)

What is a 3D image
Our human optical system surveys a scene and transmits messages to our
brain which are, in fact, the contents of two simultaneous, two-dimensional
images, spaced about three inches apart. In making a 3D image we need to
convince our optical system that, just as in real life, the two flat images
presented add together to make a stereoscopic (3D) picture. In Victorian times
‘bioscope scenes’ viewed with a hand-held stereo viewer were very popular.
Two pictures were taken of a scene and pasted together side-by-side for
viewing through simple lenses. They were very good with excellent depth and
clarity.

How to do it.

The first requirement is to take two pictures of the scene, one left, one
right. Obviously it's best unless using a specialist stereo camera, to avoid
scenes with movement. The viewpoint for pictures for most normal scenes,
using say a 35mm to 100mm focal length lens (35mm photography) need to
be about 3 inches apart - this is the average distance between the left eye and
the right eye. Special devices can be bought to do this with extreme precision,
however it can be done quite successfully by the ‘rock from one foot to the
other’ method. To do this take one picture (left) then rock from the left foot to
the right so as to lean to the right - go about 3 inches (75mm) keep everything
level and without twisting the camera, take the second shot (right). ‘Toeing-in’
An improvement upon the simple ‘move to the right’ method can be made by
"toeing-in’.

This is what you do. When taking the left shot, look at the centre of the
scene area for a ‘reference object’ and remember where it is within the frame.
After moving the 3 inches to the right, pan the camera back into the original
scene area (this is ‘toeing in’).

Place the ‘reference object’ in the same spot as it was in the left image.

Take the shot.
The slight ‘pan’ almost re-aligns the image elements, however, they

remain displaced by 3 inches to the right and this gives the stereo effect.
The “toeing-in’ is to reduce the amount of image area a that spills beyond the
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frame of each shot when combined in the ‘anaglyph’. In this way a more
complete image area is retained. Actually it's far easier and more obvious to
do than explain! The two resulting pictures can be viewed as a stereo pair. If
they are slides, then a double viewer can be used to recreate the 3D scene.

If prints, then | find that placing two 5" x 7" prints (one ‘left’, one right’) side by
side about 3 feet away and deliberately going cross-eyed to view them works
crudely. Some people find that going cross-eyed is not at all easy - so it’s not
something that | would recommend.

An Anaglyph
A popular form of 3D picture is a two-colour image that recreates

depth by making each half of the stereo pair a different colour, this is known
as an ‘anaglyph’. Usually red and green is chosen for this. To achieve a result
we need to make the left eye image red and the right eye image green. (This is
the convention, it could just as easily be the other way around - provided we
view it that way). Digital imaging has made the production of anaglyphs
simple. The word anaglyph incidentally, derives from the Greek - anaglyphos,
anaglyptos - in low relief - ana, up/back, glyphein, to engrave or carve.
‘Anaglypta’ wallpaper has the same derivation!

Making an Anaglyph (red/green) 3D picture

What follows looks long-winded because I've detailed every step. In
practice the whole process is very quick and | can run through it all, once
scanned in, to a final 3D image, ready to print, in under two minutes - honest!

1 Import/scan the ‘left’ and ‘right’ images into Photoshop in the usual way.
NB Should the images be JPEG files, convert them to .PSD (Photoshop) files by
‘Save As’.

If the images remain as JPEG's, the ‘Duplicate Channel’ functions listed below
will not function correctly.

2 Make any obvious corrections, bearing in mind that the two images will
ultimately overlap each other to form a single optical composite.

NB Do not make any alterations to the pixel dimensions either by ‘Cropping’
or ‘Transformation’ at this stage.

If alterations are made, the ‘Duplicate Channel’ functions listed below will not
function correctly.

3 Go to the ‘left’ image and de-saturate it. Do this via Image > Adjust >
Desaturate
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4 Go to the Channels palette and click on the RED channel (it highlights in
blue)

5 Go to the horizontal right facing arrow at the top right of the channels
palette and click. In the menu that opens choose ‘Duplicate Channel’

6 In the dialogue box that opens go to the Document box and click on the
drop-down arrow and choose ‘New’

7 In the ‘Name’ box (not the ‘document’ box), type in the name of the image
you are working on. (If you've already saved the left and right originals then
choose another title otherwise the system will have great pleasure in telling you
that the file name is already in usel). Click ‘OK’.

A new monochrome image will now appear

8 Minimise or close the ‘left’ original. Keep the new monochrome image
running

9 Go to the ‘right’ image and Desaturate it. Do this via Image > Adjust >
Desaturate

10 Go to the Channels palette and click on the GREEN channel (it highlights
in blue)

11 Go to the horizontal right facing arrow at the top right of the channels
palette and click. In the menu that opens choose ‘Duplicate Channel’

12 This time in the dialogue box that opens, go to the ‘Document’ box, click

on the drop-down arrow and choose (click on) the file name you gave in step
7. Click ‘OK’

13 Go back to the ‘right’ original and repeat steps, 10, 11, 12 this time
selecting the BLUE channel in step 10

14 Minimise or close the right original

15 With the monochrome image running, created from the three separate
colour channels (red = left, green & blue = right), go to > Image > Mode >
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RGB and as if by magic, the monochrome image becomes a red/green (and
blue) anaglyph

16 Put on your stereo red/green spectacles and view in glorious 3D

17 All should be well but some adjustment may be necessary. See ‘tweaks’ on
the next page.

18 Print the picture to matt paper as reflections from a glossy surface may be
distracting

Tweaks and adjustments

NB. To make ‘global” changes to the image, change from the Channels
palette to the Layers palette, otherwise you may find that you are adjusting one
colour channel only! Sharpening: Use ‘unsharp mask’ at an appropriate level.

Brightness:

As viewing via red/green spectacles can darken the scene, extra
brightness is often required. This is best done via an ‘Adjustment Layer’ (Layers
> New > Adjustment Layer > Brightness & Contrast). ‘Levels’ or ‘Curves’ may
suit you better, it depends upon what you need to do to the scene. Anyway,
‘Adjustment Layers’ are preferred for the task as they can be altered later
without detriment to the image. Take care if you choose to erase parts of the
Adjustment Layer mask by painting with black as it will be painting in two
areas simultaneously! For more information about Adjustment Layers click on
the link at the base of this page.

Re-alignment:
Should the two images be mis-aligned then some adjustment is possible. This
is best done with the red channel, as altering green would also mean altering
its partner - the blue.
Go to ‘Channels” and activate/highlight the red channel. Activate the ‘eye
icon” in the RGB channel - this automatically opens the green & blue channel
eye icons too.
Next, Select > All (Ctrl + A) (If you're using P’shop version 5 or 5.5 then Select
> All isnt necessary).
Choose the Move tool and adjust by the four direction-arrow keys to the right
of the ‘qwerty” keyboard area to incrementally shift up, down or left, right.
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Shifting left or right will decrease or increase apparent special
separation. Viewing with the ‘grid’ visible (Ctrl + Alt + @) will help to
accurately align. To close the ‘grid), repeat, Ctrl + Alt + @ The image (Red
channel in this case) can also be rotated if required - do this via Edit >
Transform > Rotate. However, remember to Select > All (Ctrl + A) first.

Wide angle and telephoto considerations:
If the original images are photographed using wide angle lenses then the
depth will be exaggerated, sometimes unacceptably so. A shift of less than 3
inches may be preferred. Conversely, long focal length lenses usually need a
wider separation to give an illusion of depth - in this case a separation of
several feet may be required between left and right pictures. However, with
greater separation it's more difficult to maintain correct registration.

Why desaturate?
The 3D picture can be perfectly well made without desaturation as outlined
above, indeed in some cases better final contrast may result. However | have
found that a more even image results if the three tonal ranges are the same to
begin with. When starting with a colour original you may prefer to use only
one of the channels available if that particular channel gives an improved
monochrome rendering of the scene.

Improving the monochrome image
Improvements to tonality and contrast can be made by using ‘Channel Mixer’
(Image > Adjust > Channel Mixer, or accessible as an Adjustment Layer). Tick
the ‘Monochrome’ box and alter the positions of the R, G, and B slider
controls to suit).

What sort of pictures work best?
In my experience the scenes that work best have many ‘planes’ of image
information, are of a gentle contrast range and avoid large, dark, featureless
areas. Dark areas frequently reveal ghost images from the other channel
which can be a distraction.

A great deal of experimentation is required to perfect the technique,
however | hope that these notes will tempt you to have a go.

Where to get the spectacles .... Cardboard framed red / green 3D
spectacles are inexpensive and may be obtained from The Widescreen Centre
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of London and Nottingham. Tel. 020 7935 2580 / 0115 945 5459 or go to
www.widescreen-centre.co.uk/webshop they also supply the stereo pair slide
viewer too.

No spectacles? - A quick alternative ....... If you have red and
green filters for B&W photography, try them (red - left, green - right).

Clive Haynes FRPS

Clive Haynes’s website is
www.crhfoto.co.uk where there is a great
deal of useful information for
photographers

Here are some other websites you may find

useful.

Royal Phographic Society
American photographic Society
for Supplies of film, cartridges and
inkjet Paper

Digital camera reviews, industry
news and firmware updates
photoexpert.epson.co.uk/uk/expertese/how+to.htm gallery,
colour profiles

WWW.rps.org
www.psa-photo.org
7dayshop.com

dpreview.com

Our thanks go to Stanley Berg ARPS APAGB for
proof-reading this issue
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Round in Circles

Circle 4
We are fortunate in that our happy band has again increased in nos due
to the fact that current members have been able to bring in others.

With UPP membership dropping could we urge all circles to do as we do
and encourage its members to seek others from within their clubs or societies.

Our rally takes place this year in North Yorkshire where we are looking
forward to meeting some of those members.

It also makes circle 4 unique, | believe within UPP. as our members run
two of Britians international exhibitions namely South Shields and Swansea.

Like all circles we have our problems and at present we are looking for a
new face to undertake the position of Secretary. Our present one wishes to
step down as he is past his sell by date and our other members are busy
people with no time to do it. We can promise you a lively circle looking at large
prints colour and black and white trade digital or darkroom work.

So if you wish to join our unique circle then get in touch.

Philip Davies Circle Secretary

Circle 7

I’'m very sad to have to report the death of Aubrey Greenslade; our
secretary of 33 years and a great friend to all members of circle 7. Aubrey
was a great contributor to the circle, his entries had a strong pictorial appeal
and his comments on other members’ work were always honest but kindly
stated. | took over from Aubrey, as circle secretary, shortly before he died.
When | had to contact the members to give them the sad news, one member
described Aubrey as “one of life’s gentlemen”. | think that says it all.

It was thought that the digital revolution in photography would
éncourage younger people into photography but it hasnt happened. Just the
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opposite it seems as it is the older photographer, converting from conventional
darkroom to digital lightroom that appear to have taken it up. Maybe only the
older generation can afford to purchase the hardware required. In circle 7 we
maintain a healthy cross section and welcome monochrome or colour,
conventionally or digitally produced or via the trade print route. Whichever
route is chosen | always think small prints can offer more of a challenge than
the larger sizes, as they cannot just rely on their size to impress; they require
pictorial impact too. We have one or two vacancies so if anyone fancies a
challenge then you will be made welcome in circle 7. Go on; give it a go, if
you think you are up to it!

Dave Bennett, Circle Secretary.

Circle 24

The last few months have been a time of consolidation. We have lost one
member and regained two former members. We continue to be a non - voting
circle which aims to encourage Contemporary/Creative work.Pictures can be
submitted as slides or prints. With only 4 Folios each year pressures to
produce that monthly picture are non existent. The note book however is
usually full of lively disacussion.

We have both digital workers and non digital workers ,but we are all
photographers. We can still take one or two extra people if our Circle appeals
to you.

Jim Marsden, Circle Secretary.

CIRCLE 29

It was something of a shock when, 30 years after initially taking over as
Secretary of C.29, in 1972, Brian Hirschfield announced that he wished to
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relinquish this position. His Secretary-ship was not continuous, due to
service abroad and at one time, while he was with the RA.F. in Germany , he
was contacted by the late Roland Jonas to say that the Circle had almost
fallen apart under the then Secretary and could he please take over? So he
stepped in and got the Circle back on course, where, under his stewardship it
soon recovered and has since thrived. As Brian himself says, he has seen the
Circle through ‘highs and lows’, with membership fluctuating from 8 to 14.
Always sefting a high standard himself - he was and is a regular G.L. winner -
the Circle has won the annual Gold Star award on several occasions. Brian’s
contribution to the Circle over the years cannot be understated. His efficiency,
his caring approach to members, and always at his own expense providing
‘extras’ such as impromptu competitions with prizes such as film and even a
camera on one occasion!, are all factors that makes him an impossible act to
follow.

During his time, the Circle changed from being a mono only Circle to
accept colour a few years ago, and more recently, it has embraced the digital
age as well. The result is that a wider range of techniques and pictures are
seen, which has added to the diversity and strength of the Circle. What hasn't
changed however, is the adherence to UPP’s original print size of a maximum
twelve square inches.. There is a special timeless charm to these small pictures
and it is this that makes C.29 unique.

Colin Westgate has now taken over as Secretary, and we have been
delighted to welcome five new members - Alan Thompson FRPS, DPAGB;
Garry Bisshopp LRPS, Monty Trent, Norma Phillips LRPS, CPAGB, and Martin
Stephenson, which has brought the Circle up to full strength. And it is great
news that Brian is staying on as an ‘ordinary’” member, from which position he
will no doubt keep a kindly eye on the new Secretary and help him resolve any
problems!

Colin Westgate FRPS MFIAP APAGB Circle Secretary

Circle 35.

My report starts on a very sad note as one of our members, Aubrey
Greenslade, died on 10" December 2003. Aubrey was one of the longest
serving members of Circle 35 and will be greatly missed. Until | took over
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from him two years ago, Aubrey had been the circle secretary for 19 years.
Our thoughts go to Ruth and all his Family.

On to general circle news, we continue to enjoy the boxes as they
circulate and the two newest members, Claire and Trevor have settled in well.
Their work has been enthusiastically received and they are giving members
plenty to think about. The general opinion within UPP seems to be that digital
is creating a resurgence in print circles that is at the expense of slide circles.
We haven't found this to be the case yet although we do have a couple of
vacancies.

We have two lady members who are proving a point that | have long
held that lady photographers often have a more pictorial eye for a picture.
Sandy and Claire certainly prove this.

Some time ago | started producing thumbnail index prints of the entries
but then dropped the idea. Compliments, followed by disappointment that |
hadn’t continued with it, has prompted me to re-introduce the idea, but only
for the entries retained for the AGM. It serves as a reminder of which entries
have been retained.

Dave Bennett, Circle Secretary.

Since sending in my circle report | have received the sad news of
the death of another of our members, Bill Jackson. He died on 18"
March following complications after a heart operation.

Bill was born in Australia and came to live in the UK in 1950. He
was a marketing manager and retired around 1985. He joined Circle
35 in September 1986 and had been an active member up until the
time he was advised fo have his operation. Despite suffering a stroke
several years ago Bill always contributed to the notebook with a lively
entry and his slides reflected an interest on a variety of subjects. He will
be greatly missed and our thoughts go out to his wife Joan and all his
family.
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Circle Secretaries
*Small Print **Large Print***Colour Slide****Digital Image

c2/25**  A.FElliott 14 Ewden Road, Barmnsley, S. Yorks, 73 0RG 01226 21 18 29

c3* R.Bennett 43 Riverside Road, Newark,Notts NG24 4RJ 01636 65 12 77
ARPS email ralph.eyesight@ntiworld.com

c4* P.J.Davies Chapel House, Oxwich Green, Gower, West Glamorgan, 01792 39 10 33

SA3 1LU email philip@light.softnet.co.uk

C6** C.Snelson ‘Joan Lear', middlesmoore, Harrowgate, N. Yorkshire 01423 75 56 91
HG3 58T email colinorann@aol.com

(o o D.Bennett 55, Highthorpe Crescent, Cleethorpe, South Humberside 01472 20 04 63
DN35 9PX  email dave.highthorpe @btinternet.com

cs** D.S.Maslen 107 Oxstalls Way, Longlevens, Gloucester, GL2 9JU 01452 52 41 71
DPAGB BPE 2*

co9* D.Apple 38 Harrow Road, West Bridgford, Nottingham, Nottinghampshire 01159 14 58 38

NG2 70U email  dennis.apple @ntlworld.com

c10** J.Butler 26, Green Way, Tunbridge Wells, TN2 3HZ 01892 52 59 02
DPAGB APAGB email  johnbutler@email.com
c11* R.Poynter 232, Limes Avenue, Chigwell, Essex, IG7 5LZ 020 85 01 14 97
ci2* DR A.Robson 66 Leeds Road, Selby, North Yorkshire, YO8 4JQ 01757 7 0 22 28
ARPS email arobson@aol.com
Cc14* P.A.Blow 39 Cogdeane Road, West Canford Heath, Poole, Dorset 01202 60 32 79
BH17 9AS email pabloid @bournemouth net.co.uk
ci7* H.C.Thompson 2 Ellesmere Rise, Great Grimsby, N.E Lincolnshire 01472 31 33 49
DN34 5PE email harold.thompson @ntlworld.com
c1g** B.W.Sanderson 36 Ruskin Court, Elthorne Way, Green Park, Newport Pagnell, 01908 61 04 43
Bucks, MK16 0JL
C19*+ P.M.Antrobus 2, Grain Mill House, ‘The Maltings', Lillington Avenue 01926 33 42 28
FRPS Leamington Spa, Warwickshire, CV32 5FF
C20+ A.J.Potter 4 Gillarran, Workington, Cumbria, CA14 4RA 01946 83 01 30

email tonypotter@hotmail.com
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ca21* H.Fisher
LRPS CPAGB

c22** R. Henstock
ARPS

C23***  M.P.Knowles

C24***  J.Marsden FRPS
AFIAP APAGB

Cc26** P.M.Antrobus
FRPS

c2g* J.W.Bullen
c29* Colin Westgate
FRPS MFIAP APAGB

C31* B.Davis
FRICS

c32* B.C.Hall

C33*** Mrs L.Molnar

C34***  C.Hildreth

C35***  D.Bennett

C36***  LW.Platt FRPS
HON EFIAP
MFIAP APAGB

A/A** P.A.Blow

NHCC1***P.T.Chadd

NHCC2*** Mrs K.Bull ARPS
EFIAP DPAGB

DI.1***  Mrs L.Boud

21 Brockwood Crescent , Leyworth, Nottingham, Notts 01159 37 28 98

NG12 5HC email howard @hfjf.co.uk

Bent Lee, Bradley, Huddersfield, West Yorkshire, HD2 1QW 01484 54 11 95

1 Homestead, Bamber Bridge, Preston, Lanashire, PR5 8BA 01772 32 19 88

22 Godwin's Close, Atworth nr Melkham, Wilts, SN12 8LD
email jimmarsden@atworth43.freeserve.co.uk

01225 79 17 28

2, Grain House Mill House, ‘The Maltings', Lillington Avenue, 01926 33 42 28
Leamington Spa, Warwickshire, CV32 5FF

13 Luard Court, Warblington, Havant, Hants, PO9 2TN
email johnbullen@iclway.co.uk

2 Maine Parade, Seaford, East Sussex BN25 2PL
email quest@photoshot.com

1 New Road, Wingerworth, Chesterfield, Derbyshire,
email brian @thedavis.co.uk

02392 47 69 78

01323 89 78 12

01246 27 54 33

49 Calder Avenue, Brookmans Park, Hatfield, Herts, AL9 7AH 01707 65 58 66
email asureshot@talk21.com

100 Grahamsdyke Stree, Lauriston by Falkirk,Stirlingshire

FK29LZ  email lavina@Ilmolnar.fsnet.co.uk

01786 82 31 73

25, Keats Close, Stevenage, Herts, SG2 0JD 01438 31 26 25

email cyril.Lhildreth @btinternet.com

55, Highthorpe Crescent, Cleethorpe, South Humberside 01472 20 04 63

DN35 9PX  email dave.highthorpe @btinternet.com

1, ‘The Brambles', Goggs Lane, Redlynch, Salisbury,
Wilts, SP5 2HP  email ianplatt@talk21.com

01725 51 16 85

39 Cogdeane Road, West Canford Heath, Poole, Dorset 01202 60 32 79
BH17 9AS email pabloid @bournemouth-net.co.uk

6, Nicholass Court, Dale Road, Purley, Surrey, CR8 2ED 01732 86 35 89

‘Segsbury’, St John's Road, Crowborough, E.Sussex, TN6 1RT
email kath.bull @btopenworld.com

01892 66 37 51

‘Barnjet’, Cuttinglye Road, Crawley Down,West Sussex, 01342 71 73 18

RH10 4LR email liz@bouddi.freeserve.co.uk

Contd
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Dl 2nu

B. Davis 1 New Road, Wingerworth, Chesterfield, Derbyshire,

pl 3**** K.Payne

ERICS S42 678 email  brian @thedavis.co.uk

38, Lodge Crescent, Waltham Cross, Hertfordshire
EN8 8BS email  kenneth.paynel @ntlworld.com

01246 27 54 33

01992 30 91 76

Dl 4**** Mrs A.Stobbs 36 Findhorn Place, Troon, Ayrshire, KA10 7DJ,

01292 31 72 25

email snapdragon@omne.uk.net

AGM 2003

19th- 21st September
at Hillsborough Conference Centre,
Birmingham

Make cheque payable to

UPP of GREAT BRITAIN
and send fo

KEN PAYNE
38 LODGE CRESCENT
WALTHAM CROSS
HERTFORDSHIRE
EN8 8BS

£11

INCLUDES POST & PACKING

406 Pictures
with
Voice-over
and
Music




President

Vice President

Immediate Past
President
Hon. Life Member

General Secretary

Treasurer

Council Members 2001 2002

J.W.Bullen
B.Davis
FRICS

L.Boud
L.A.Holman
S.Berg

ARPS APAGB

W.B.Evans
FRPS APAGB

F.A.H. Ouvry
LRPS

Membership Secretary L.Boud

Publicity Secretary

Editor, ‘Little Man’

Competiton Secretary

( Slides)

Competition Secretary

(Prints)

Stationery Officer

Circle Secretaries
Representative

Ordinary Member's

Representative

Web Master

Co-opted Member

A. Swearman
APRS DPAGB
APAGB

W.Steiner

P.J.Davies

K.Payne

B.Davis

FRICS

P.A.Blow

R.Bennett

R.Moore

DPAGB

A.T.E. Homes
APAGB

13, Luard Court, Warblington,
Hants, PO9 2TN email johnbullen @iclway.co.uk

1, New Road, Wingersworth

023 92 4769 78

01246 27 54 33

Chesterfield, Derbyshire, S42 6TB email brian@the davis.co.uk

‘Barnjet’, Cuttinglye Road, Crawley Down
West Sussex, RH10 4LR email liz@bouddi.freeserve.co.uk

14, Littlecoats Road,Grimsby
N.E_Lincolnshire, DN34 4LY email |.holman@ntlworld.com

68, Mowbray Road, Edgware
Middlesex, HA8 8JH

18, Buttermere Close, Cockermouth,
Cumbria, CA139JJ  email barryevans @onrtel.net.uk

17 Tebourba Drive, Alverstoke,
Gosport, Hants, PO12 2TN email ouvry @ btopenworld.com

‘Barnjet’, Cuttinglye Road, Crawley Down
West Sussex, RH10 4LR email liz@bouddi.freeserve.co.uk

30, St Lucia Close, Whitley Bay, Tyne & Wear
NE26 3HT email anne@swearman.fsnet.co.uk
Longlands, Quarry Heads Lane, Durham

DH1 3DY email walter.steiner@btinternet.com

Chapel House, Oxwich Green, Gower
West Glamorgan, SA3 1LU email philip@light.softnet.co.uk

38 Lodge Crescent, Walthgam Cross
Hertfordshire, EN8 8BS email kenneth.paine1 @ntiworld.com

1 New Road, Wingersworth,Chesterfield
Derbyshire, S42 6TB email brian@the davis.co.uk

39 Cogdeane Road, West Canford Heath, Poole,
Dorset, BH17 9AS email babloid@bournemouth-net.co.uk

43 Riverside Road, Newark
Notts, NG24 4RJ email ralph.eyesight@ntlworld.com

32 Maryland Drive, Maidstone, Kent
ME16 9EW email roymoore @maidstone32.freeserve.co.uk

22, Wycherly Crescent, Barnet
Hertfordshire, EN5 1AR email ala.homes@nasuwt.net
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01342717318

0147258 9877

020 89 58 95 55

01900822479

023 92 58 06 36

01342717318

01912533130

01913 86 46 62

0179239 1033

01992 30 91 76

01246 27 54 33

01202 60 3279

01636 65 1277

01622 72 76 34

020 84 40 34 33

Totally new.
Yet much the same.

Fast, quiet, precise and optically perfect - that's what the
legendary LEICA M has been for nearly five decades. The
NEW LEICA M7 now raises convenience and quickness to new
heights by means of a stepless automatic shutter speed
control - making M-photography surprisingly fresh and
familiar at the same time. Available at your LEICA dealer.

www.leica-camera.com

my point of view

Leica Camera Ltd, Davy Avenue, Knowlhill, Milton Keynes, MX5 8LB. Telephone: 01908 246300 for literature or 01908 666663 for general and service enquiries



